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Chapter 1: IN Carta Image Analysis Software

The IN Carta® Image Analysis Software provides powerful analytics for advanced phenotypic
classification and 3D image analysis. It delivers robust, quantitative results from complex
biological images and datasets using advanced AI technology.

Faster Data

Intuitive design makes complex analysis accessible with minimal training.
Shorten analysis time with true parallel processing.

Reliable Data

Sophisticated algorithms generate reliable data with minimal user input.
Improved segmentation algorithms represent cellular structures more accurately.

Results That Matter

See real results quickly—from populations to single cells—using integrated data
visualization tools.
User-friendly interface guides you through your discoveries with continual updates that
grow with your needs.

Terminology

The following table defines the terms and abbreviations used in this guide.

Term Definition

Annotation User-created labeling (target/background) of input data to define areas of interest.

Background Area of an image that is not of interest.

Base Model One of the pre-trained neural network models provided with the IN Carta SINAP

module for a range of segmentation applications.

Epoch Single iteration of learning algorithm working through entire training set in an

attempt of creating a model.

FOV Field of view

Ground Truth User-annotated input data

Input data Images

Model Trained deep-learning neural network

ROI Region of interest

Target Biological structure that is of interest

Training Set Set of annotated images used to train a model

1
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Obtaining Support

Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products and to
fully supporting our customers with the highest level of technical service.

Our Support website—www.moleculardevices.com/service-support—describes the support
options offered by Molecular Devices, including service plans and professional services. It also
has a link to the Molecular Devices Knowledge Base, which contains documentation, technical
notes, software upgrades, safety data sheets, and other resources. If you still need assistance,
you can submit a request to Molecular Devices Technical Support.

Technical Support

To contact Molecular Devices Technical Support, submit a support request through the
Molecular Devices Knowledge Base at support.moleculardevices.com.

You can also submit a support request by phone. For regional support contact information, go
to www.moleculardevices.com/contact.

To expedite support, be prepared to provide the software version and your activation ID. To

display this information, at the bottom left of the IN Carta window, click Settings.

Documentation

Review the product documentation on the Molecular Devices Knowledge Base at
support.moleculardevices.com. In addition, online Help is available within the IN Carta software.

Additional Resources

Web-based microscopy courses:

www.microscopyu.com
www.ibiology.org/ibioeducation/taking-courses/ibiology-microscopy-short-course.html

The Molecular Probes Handbook offers advice on fluorescent probes and can help you
determine if there are better stains available for your analysis:

www.thermofisher.com/us/en/home/references/molecular-probes-the-handbook.html

The Assay Guidance Manual details state-of-the-art approaches to high-content screening
(HCS) and discusses challenges specific to HCS. It serves as a good introduction for new HCS
practitioners.

www.ncbi.nlm.nih.gov/books/NBK100913

About This Guide

This guide is intended for the scientist using the IN Carta software. It provides an overview of
the IN Carta SINAP module and describes how to use IN Carta SINAP to run your methods.

The information in this guide is valid for IN Carta software version 2.1 and is subject to change
without notice. We recommend that you review the guide on the Molecular Devices Knowledge
Base at support.moleculardevices.com for the most up-to-date information.

https://www.moleculardevices.com/service-support
https://support.moleculardevices.com/
http://www.moleculardevices.com/contact
https://support.moleculardevices.com/
http://www.microscopyu.com/
http://www.ibiology.org/ibioeducation/taking-courses/ibiology-microscopy-short-course.html
https://www.thermofisher.com/us/en/home/references/molecular-probes-the-handbook.html
https://www.ncbi.nlm.nih.gov/books/NBK100913/
https://support.moleculardevices.com/
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Chapter 2: IN Carta SINAP Module

The IN Carta SINAP module uses machine learning as an aid for creating annotated ground
truth training sets for the deep-learning component of the IN Carta software.

Deep learning is an area of AI that uses multi-layered neural networks to mimic the way that the
human brain processes information. A network becomes more accurate as it is provided with
more ground truth data from which to learn.

With deep learning, there is no requirement to define specific features of interest. A model
learns in a similar way to humans; as a result, it can outperform traditional segmentation
methods in many applications.

Note:
An additional license is required to use the SINAP module. Many functions are available
to all users, including training/applying/saving a model and applying analysis settings for
SINAP segmentation to an image. However, the following functions are not available
without a valid license:

Saving a protocol with SINAP segmentation.
Running a protocol with SINAP segmentation.

If you are running the IN Carta software with a network license, you may be able to
reserve a license to access the SINAP module. See Settings for details.

2
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Deep-Learning Segmentation

Segmentation is the foundation of the image analysis pipeline, allowing researchers to identify
regions of interest in tissue, whole organisms, individual cells, nuclei, and organelles. Through
segmentation, researchers can extract information from images to quantitatively compare
differences across diverse concentrations, treatments, time, genetics, and so on.

Segmentation is the foundation for every analysis that follows, so accuracy is crucial. Reliable
identification of structures, shapes, and sizes is vital for robust analyses. Errors in segmentation
will be propagated and multiplied through the rest of the analysis, effectively lowering the assay
robustness (less accurate dose curve, inability to detect small modulations of a phenotype,
lower Z' for classification experiments). This leads to false-positives and false-negatives, and it
ultimately wastes time, money, and resources.

Current segmentation algorithms often struggle to deal with non-optimal images where poor
contrast, signal variability, or high complexity of biological structures mean that you must
compromise your analyses and work with a solution that accommodates some of their data, but
not all. This results in multiple, specialized tools, each suited for an application or dataset, which
often require training to be used effectively.

The advent of artificial intelligence (AI) has improved the situation. The development of
computer systems able to perform tasks through machine- and deep-learning— tasks such as
visual perception, speech recognition, decision-making, and translation between languages—
has addressed some of the intractable problems. These solutions still require a large amount of
annotated ground truth data to create a reliable, accurate training set.

A learning algorithm capable of being taught to detect the biology in which a researcher is
interested is required.

The SINAP module is a trainable segmentation module that uses both classic machine learning
and deep learning in an intuitive format to produce robust, reliable segmentation across a wide
variety of applications.
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Pre-Trained Models

The SINAP module uses pre-trained base models to reduce the requirement for large amounts
of annotated ground truth data. This saves time and reduces the amount of data required for a
model to be accurate. If a model is a good match for the target of interest, the fine tuning only
requires a few annotated images to be added to a training set.

When the structure of interest is dissimilar to the images used to train a model, the performance
of the model may not be optimal. In this case, you can re-train an existing model to suit their
application.

Re-training a model using the SINAP module adopts an iterative approach, where you add more
annotated ground truth data until the model accurately differentiates the target from the
background. This takes longer than fine-tuning and requires more data in the training set.
Timing and size of the training set is highly variable and is dependent on how different the
structures are to the base model and complexity of the problem.

In either case, when you are satisfied with the performance of the model, you can save and
apply it to the full dataset. The saved model will also be available as a pre-trained model for
subsequent use in other experiments, as shown below.
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Chapter 3: Using the SINAP Module

This section contains instructions on how to run your methods using the SINAP module.

Saving Data and Data Storage, see below
Launching SINAP Application, see page 12
Creating a New Protocol with Deep-Learning Analysis, see page 13
Refining a Pre-Trained Model, see page 14
AI-Assisted Segmentation, see page 15
Manual Segmentation, see page 17
Using a Training Set to Train a Model, see page 18

Saving Data and Data Storage

Consider the following when working with the SINAP module:

After saving a model, you cannot delete or overwrite it.
Upon editing and saving, a new model is created with a unique identifier.
Training set data is stored in a temporary folder while the SINAP application is being used.
Each time the SINAP application is started, all previously stored training-related data is
deleted.
If you close the SINAP application without saving a model, any changes made to the model
are lost.

3
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Launching SINAP Application

To launch SINAP:

1. From the Worklist page, click the experiment you want to open.
2. If results exist for the experiment, click New.

The Interactive: Analyze page opens. In the Protocol Editor Table, the Application tab
displays.

3. On the Application tab, click Flexi-Protocol to start the segmentation workflow.

To use a pre-trained model with no further input or training, see Creating a New Protocol with
Deep-Learning Analysis on page 13.

To refine or create a new model, see Refining a Pre-Trained Model on page 14.
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Creating a New Protocol with Deep-Learning Analysis

Part Name

1 Protocol Editor Table

2 Analysis Settings

To create a new protocol with deep-learning analysis:

1. In the Protocol Editor Table, on the Protocol tab, click New to create a new protocol.

2. On the Modify tab, click Add a New Target to add rows for each target, as needed.

3. Assign a Target Type for each target (either Nuclei, Cells, or Organelles).
4. In the row for each target for deep-learning analysis, click the Segmentation drop-down,

and select SINAP.
5. In the Display Name field, enter a display name for the protocol (for example, nuclei,

puncta, mitochondria, other structure, and so on).
6. Click the Wavelength drop-down list, and select a channel of interest.
7. In Analysis Settings, click the Pre-trained Model drop-down, and select a model.

Tip: See the IN Carta Help for details on other Analysis Settings options.

8. Click Apply.
9. If you are satisfied with the segmentation, in the Protocol Editor Table, click Run Protocol to

analyze the dataset. Otherwise, see Refining a Pre-Trained Model on page 14.
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Refining a Pre-Trained Model

Consider the following when generating a training set:

Different methods of adding images to training set can be used to generate a training set.
You can use ROI (Region of Interest) to specify a properly segmented region within an
active image. When you click Add to Training Set with ROI active, the software adds only
the ROI to the training set. Click inside the ROI to change its size or position.
You can add multiple ROIs to a training set for any FOV.
It is important to consistently label the image. Poor quality ground truth is the biggest
obstacle to quickly training a model.

Tip: It is more important to label the right pixels than to label many pixels. You can
find the most useful information at boundaries between target and background. Use

the Brush tool to precisely annotate these areas.

You can annotate the same input images differently to train a model to recognize a new
target. In this way, you can train models to recognize multiple targets from the same input
images.

To refine a pre-trained model:

1. In the Protocol Editor Table, click SINAP to open the SINAP window.
2. In the Image Selection pane, select the Channel, Row, Column, Time, and Z-slice from the

drop-downs.

Part Name

1 Image Selection Pane

2 Label Pane

3 Neural Network Segmentation Pane
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AI-Assisted Segmentation

When a pre-trained model produces results that are close to expected and require minor
corrections, you only need to fine-tune the model to correct areas that have been mislabeled as
Target or Background. See Workflow 1: Minor Corrections on this page for details.

In some cases, a model may produce suboptimal segmentation and requires training. See
Workflow 2: Major Corrections on page 16 for details.

Workflow 1: Minor Corrections

Use this workflow if a model produces optimal segmentation and requires minor corrections.

To make minor corrections:

1. In the Image Selection pane, click Random FOV to select a field of view.
2. On the right side of the screen, click Adjust and use the sliders to modify the brightness and

contrast.
3. (Optional) To make image segmentation faster, define a region of interest by clicking ROI.
4. In the Neural Network Segmentation pane, click the Model drop-down, and select the

model.
5. Click Apply.
6. In the Overlays pane, use the Annotations and Segmentation sliders to adjust the opacity

of the masks.
7. In the Labels pane, do one of the following:

Select Background to train the model to remove false-positive regions.
Select Target to train the model to remove false-negative regions.

8. Use the labeling tools to annotate example regions for Target and Background.

Brush: Click to activate and then drag to draw a free-hand line. Displays in blue
when active. Use the slider under the button to adjust line width.

Segmented Line: Click to activate and then drag to create a line with segments.
Release to end the segment. Double-click to end the line. Displays in blue when active. Use
the slider under the button to adjust line width.

Polygon: Click to activate and then drag to create a filled polygon for the selected
label type. This tool is useful to quickly annotate large regions in an image. Each click adds
a node or corner to the polygon. Double-click to end the polygon. Displays in blue when
active.

Connected Components: Click to automatically create an annotation by tracing
an image region with intensities similar to selected pixel. Use the slider to control the
tolerance for intensity similarity. Lower tolerance results in smaller annotated regions; at
higher tolerance, regions are larger. Displays in blue when active.

Select the Fill Holes check box to fill holes in the annotated area.
Click within a biological object of interest. The calculated annotation mask displays
within red box. At this point, the mask is not yet added as an annotation.
As needed, add more annotations to correct the segmentation. Hold SHIFT and click
anywhere in the Image Viewer to add a mask as an annotation.

9. Click Correct to apply the annotations to the segmented image.
10. When you are satisfied with the segmentation of the image, click Add to Training Set to add

the FOV or ROI to the training set.
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Workflow 2: Major Corrections

Use this workflow if a model produces sub-optimal segmentation and requires more ground
truth images to be added for training.

To make major corrections:

1. In the Image Selection pane, click Random FOV to select a field of view.
2. On the right side of the screen, click Adjust and use the sliders to modify the brightness and

contrast.
3. (Optional) To make image segmentation faster, define a region of interest by clicking ROI.
4. Use the labeling tools to annotate example regions for Target and Background.

Brush: Click to activate and then drag to draw a free-hand line. Displays in blue
when active. Use the slider under the button to adjust line width.

Segmented Line: Click to activate and then drag to create a line with segments.
Release to end the segment. Double-click to end the line. Displays in blue when active. Use
the slider under the button to adjust line width.

Polygon: Click to activate and then drag to create a filled polygon for the selected
label type. This tool is useful to quickly annotate large regions in an image. Each click adds
a node or corner to the polygon. Double-click to end the polygon. Displays in blue when
active.

Connected Components: Click to automatically create an annotation by tracing
an image region with intensities similar to selected pixel. Use the slider to control the
tolerance for intensity similarity. Lower tolerance results in smaller annotated regions; at
higher tolerance, regions are larger. Displays in blue when active.

Select the Fill Holes check box to fill holes in the annotated area.
Click within a biological object of interest. The calculated annotation mask displays
within red box. At this point, the mask is not yet added as an annotation.
As needed, add more annotations to correct the segmentation. Hold SHIFT and click
anywhere in the Image Viewer to add a mask as an annotation.

5. Click Segment pane to segment the current FOV.
The software uses a machine learning model to predict all unlabeled pixels in an image,
assigning them as either Target or Background.

Note: You can re-use this model for any new FOV that is loaded or when the ROI is
moved to a new position.

6. If the resulting segmentation mask is not satisfactory, add more annotations, and segment
again.

Note: If the results that are close to expected, consider fine-tuning the model to
correct areas that have been mislabeled. See Workflow 1: Minor Corrections on page
15 for details.

7. When you are satisfied with the segmentation of the image, click Add to Training Set to add
the FOV or ROI to the training set.
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Manual Segmentation

When applying a segmentation model or clicking Segment produces unsatisfactory results, you
may want to train a model by annotating only the target structures in single or multiple fields of
view. In this case, all unlabeled pixels are assigned as background.

To perform manual segmentation:

1. In the Image Selection pane, click Random FOV to select a field of view.
2. On the right side of the screen, click Adjust and use the sliders to modify the brightness and

contrast.
3. Use the labeling tools to annotate the structures of interest as Target. All unlabeled pixels

will be assigned as Background.

Brush: Click to activate and then drag to draw a free-hand line. Displays in blue
when active. Use the slider under the button to adjust line width.

Segmented Line: Click to activate and then drag to create a line with segments.
Release to end the segment. Double-click to end the line. Displays in blue when active. Use
the slider under the button to adjust line width.

Polygon: Click to activate and then drag to create a filled polygon for the selected
label type. This tool is useful to quickly annotate large regions in an image. Each click adds
a node or corner to the polygon. Double-click to end the polygon. Displays in blue when
active.

Connected Components: Click to automatically create an annotation by tracing
an image region with intensities similar to selected pixel. Use the slider to control the
tolerance for intensity similarity. Lower tolerance results in smaller annotated regions; at
higher tolerance, regions are larger. Displays in blue when active.

Select the Fill Holes check box to fill holes in the annotated area.
Click within a biological object of interest. The calculated annotation mask displays
within red box. At this point, the mask is not yet added as an annotation.
As needed, add more annotations to correct the segmentation. Hold SHIFT and click
anywhere in the Image Viewer to add a mask as an annotation.

4. Click Correct.
5. Repeat steps 3 and 4, as needed.
6. When you are satisfied with the segmentation of the image, click Add to Training Set to add

the FOV or ROI to the training set.
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Using a Training Set to Train a Model

After adding images to the training set, you can use them to train a model.

To train a model using a training set:

1. In the Neural Network Segmentation pane, do one of the following:
Click Default to select a default model from the drop-down.
Click Custom to select a saved model from local or network storage. Saved models are
stored in the C:\ProgramData\TSModels folder.

2. As needed, click Advanced to set parameters that further adjust segmentation options and
optimize training:

Under Image Segmentation, select the Supplement Splitting check box to activate the
algorithm used for additional splitting of objects. The same check box is available in the
Analysis Settings for SINAP segmentation.
Under Model Training, select the Fine Tune option when the prediction model makes
minor mistakes with a new dataset. Select the Retrain option when the biological
structure to segment is significantly different from the structure used to generate the
original model.
In the Epochs field, enter the number of iterations performed during the training
process. Use a higher number of epochs to generate a more accurate model. Note that
training time is dependent on the epoch number, so increasing the number of epochs
increases training time. For fine-tuning, we recommend using between 30 and 200
epochs. For retraining, we recommend using between 200 and 1,000 epochs.

3. Click Train to train the model based on the images in the training set.
4. Test the segmentation on the new FOVs to check performance.

Note: If the segmentation results are not robust enough, add more images to the
training set.

5. If you are satisfied with the segmentation results, click Save.
6. Enter the name of the new model, and click OK.

Note:
Saved models are stored in the c:\ProgramData\TSModels folder.
Click Manage to open the Model Manager dialog, which enables you to review a
list of saved models and remove models that are no longer needed.
Note that removed models are not deleted; they remain in the
c:\ProgramData\TSModels folder.

You can now access the model in Analysis Settings when using the Flexi-Protocol application.
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Chapter 4: Troubleshooting

This section contains troubleshooting information for the SINAP module.

Updating Parameters for an Underpowered GPU, see below
Diagnosing GPU Issues, see page 20

Updating Parameters for an Underpowered GPU

The SINAP module requires a supported Nvidia graphics processing unit (GPU) with the latest
driver and a CUDA compute capability of at least 3.5.

Note:
For more information on the compute capability of your Nvidia GPU, go to
developer.nvidia.com/cuda-gpus.
See the IN Carta Installation Guide for details on verifying the GPU driver for the
IN Carta software.

If your Nvidia GPU has less than 24 GB memory, the IN Carta software attempts to automatically
adjust the GPU-related settings. In some cases, however, you may need to update the neural
network parameters in order for SINAP to run. If the neural network parameters have not been
properly updated, the following message displays.

To update parameters for an underpowered GPU:

1. In Window File Explorer, browse to the c:\Program Files\INCarta folder.
2. Double-click params_config.bat.
3. Follow the on-screen instructions to update the neural network parameters. The following

table lists the default and recommended values:

Type Parameter Default Value Recommended Value

Train crop_size 1024 512 (if fails, set to 256)

batch_size 2 1

Prediction num_blocks_x 1 2 (if fails, set to 4)

num_blocks_y 1 2 (if fails, set to 4)

4
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Diagnosing GPU Issues

Use the Neural Network Diagnostic Tool to run a suite of experiments to test whether your
graphics processing unit (GPU) hardware and software are appropriate for the SINAP module. If
the initial tests do not succeed, the tool automatically runs the tests again with different settings.
When it determines the best possible settings, the tool updates the IN Carta software
accordingly.

If you are having issues running the SINAP module, run the Neural Net Diagnostic tool to test
your GPU.

Note: The Neural Network Diagnostic Tool can take around 10 to 15 minutes to run.

To diagnose GPU issues with the Neural Network Diagnostic Tool:

1. In Window File Explorer, browse to the c:\Program Files\INCarta folder.
2. Right-click diagnostic.bat and select Run as administrator.
3. If the tests succeed, the GPU hardware and software are compatible with the

SINAP module. Try running the SINAP module again.
4. If the tests fail, do the following:

a. At the top left of the Diagnostic.bat window, click , and select Edit > Select All.

Note: Do not press CTRL + A. Do this will clear the output and close the window.

b. Click , and select Edit > Copy.
c. Paste the output into any text editor (for example, Notepad).
d. Save the text file. It will be helpful to diagnose the issue.
e. Contact Molecular Devices Technical Support. See Obtaining Support on page 6 for

details.
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